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Welcome to onOne Software™ PhotoFrame 4.5 

Add the perfect finishing touch to your images with PhotoFrame 4.5.5 Professional Edition. It features over a thousand of 
design elements like film edges, borders, textures, backgrounds and adornments. It even has complete layouts where you 
just drop your image in and you are done. It's the easiest and fastest way to add an authentic darkroom touch with a film 
edge or to create beautiful albums or scrapbook pages. It includes all the tools you need to find the perfect design elements, 
add them to your image and control things like size, color and opacity. You can even stack multiple elements to create your 
own designs and save them as a preset you can use in a single-click inside of Photoshop, Lightroom or Aperture. 
 

● Over a thousand professionally created edges, backgrounds, textures and adornments. 
● Easily add authentic film and darkroom edge effects. 
● Complete album layouts built-in or create your own inside of PhotoFrame. 

 
 

Looking for Information?   
If you're unable to find what you're looking for in this help system, try these alternative resources, or contact our customer 
support department. 
 
 
Most popular pages 

● Welcome 
● Additional Resources 
● Contacting onOne Software 
● Library Interface 
● Installation 
● System Requirements 
● Activation and Registration 
● Applying a Preset 
● What's New in PhotoFrame 4.5 
● Destination Tab 
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Using this Help System 

The user guide for PhotoFrame 4.5 is presented in html and is readable in most web browsers. When you access the user guide from the help menu it will 
appear in your default web browser.  

On the right side you will see a table of contents that makes it easy to find the section you are looking for. The table of contents are hyperlinks that will 
take you to that section when you click on any of them. The main body of the page will show you the content you have requested. Use the scroll-bar at the 
right to scroll down for additional content. You may see additional hyperlinks in the body text. They will be blue and underlined. Clicking on one of these 
hyperlinks will take you to more relevant information. 

You use the same forward and back buttons in your browser to navigate this user guide as you would a regular web page. You can even bookmark pages 
so you can find them quickly in the future. 

If you don't see what you are looking for in the table of contents, try the search field. You can type in what you are looking for and an index of pages will 
be created automatically that contain your search term. 

Printed Manual 

If you prefer a printed manual, you can open this PDF version of the manual which allows for printing. It does require the free Adobe Acrobat Reader to 
view it. 

 
 
 

See also 

Additional Resources 
Contacting onOne Software 
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Additional Resources 
 
 
Check the Hot Topics  

  Check the list of Hot Topics on the onOne website. The covers the most commonly asked questions. 
 
 
Ask Someone  

  Post a question or search for an answer in our online user forum. 
 

 
Knowledgebase 

  Search the knowledgebase for common bugs, tips & tricks, and compatibility issues with other software. 

 
 
Video Tutorials 

  Check the online video tutorials. 
 
 
Technical Support 

  Contact technical support by filing out a request form. 
 

 
onOne Exchange  

  You can find more frames and presets as well as share your presets for PhotoFrame and other onOne products at the onOne Exchange.
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Contacting onOne Software 

onOne Software, Inc. 
15350 SW Sequoia Parkway Suite 140  
Portland, OR 97224  

Phone Main: 503-968-1468 
Fax: 503-968-1469  

http://www.onOnesoftware.com  

For Technical Support please visit:  
http://www.onOnesoftware.com/support 

Sales  
For sales please call 1-888-968-1468 

 
 
 

See also 

Using this Help System 
Additional Resources 
 
 
 

© 2009 onOne Software, Inc. All rights reserved. onOne Software is a registered trademark of onOne Software, Inc. The onOne Software logo, and 
PhotoFrame are trademarks of onOne Software, Inc. Adobe, Photoshop, Photoshop Elements, Photoshop Lightroom, Flash and Acrobat are trademarks of 
Adobe Systems, Incorporated. Mac OSX, the Mac logo and Aperture are trademarks of Apple, Inc., registered in the U.S. and other countries. Microsoft, 
Windows, Windows XP, Windows Vista and .NET are registered trademarks of Microsoft Corporation. All other trademarks are the property of their 
respective owners. 
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Articles in this section 

  

 
 

 
System Requirements 

 
Installation 

 
Uninstalling 

 
Activation and 
Registration 
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System Requirements 

 
 
 

  Macintosh  Windows  

Operating 
System  

 Mac OSX 10.5, 10.6 (current maintenance releases)  Windows XP, Windows Vista, Windows 7 (current maintenance 
releases)

 Processor  PowerPC G5 or Intel Core  Pentium 4 or similar

 Memory  2GB RAM  2GB RAM

 Hard Disk  2GB Hard Disk Space  2GB Hard Disk Space

 Display  OpenGL 2.0 capable video card with 128MB VRAM running at 
1024x768 (1280x1024 or higher recommended)

 OpenGL 2.0 capable video card with 128MB VRAM running at 
1024x768 (1280x1024 or higher recommended)

 Host 
Application 

 Adobe Photoshop CS2, CS3, CS4 
 

Adobe Photoshop CS2, CS3, CS4 
 

 Optional 
Integration 

 Apple Aperture 2.1 
Adobe Photoshop Lightroom 2  
(Lightroom integration requires a full version of Photoshop)

 Adobe Photoshop Lightroom 2  
(Lightroom integration requires a full version of Photoshop)

 Other

Internet connection for activation, auto updates and video 
tutorials 
Adobe Flash 10 player 
DVD drive for installation from disc 
Administrator privileges to install and uninstall

Internet connection for activation, auto updates and video 
tutorials 
Adobe Flash 10 player 
DVD drive for installation from disc 
Administrator privileges to install and uninstall 
Microsoft .NET 3.5 framework or higher (installed automatically if 
missing) 
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Installation 

To install PhotoFrame, double-click the installer. You may have downloaded it from the onOne Software web site or if you have the boxed version you can 
find it on the provided DVD.  

Macintosh  

● The default installation installs all necessary files into all supported versions of Photoshop, Photoshop Elements, Photoshop Lightroom and Aperture 
found during the installation process.  

● If the selected parent application contains a previous version of PhotoFrame, it will be replaced.  
● The PhotoFrame plug-in is installed in the Plug-Ins folder inside the Photoshop application folder.  
● The PhotoFrame content and databases are installed into the general Application Support folder: /Library/Application Support/onOne 

Software/PhotoFrame 4.5.  
● All other required files and documentation are installed in the PhotoFrame folder in the user’s Applications directory.  

Windows  
 

● PhotoFrame will list all available versions of Photoshop, Photoshop Elements and Photoshop Lightroom when the installer is run. Select which host(s) 
you wish PhotoFrame to be installed into. 

● The installer will install in to one version of Photoshop at a time. If you wish to install PhotoFrame into multiple versions, simply run the instaler a 
second time.

● If the selected parent application contains a previous version of PhotoFrame, it is replaced.  

● The PhotoFrame plug-in is installed in the Plug-Ins folder inside the Photoshop application folder.  
● The PhotoFrame content and databases are installed into the C:\Documents and Settings\All Users\Application Data\onOne Software\PhotoFrame 

4.5 directory.All other required files and documentation are installed in the PhotoFrame Pro 4 directory in the user’s Program Files.  

 

See also 

System Requirements 
Uninstalling 
Activation and Registration 

 

 Important: PhotoFrame 4.5 will replace a previous version of PhotoFrame. It will automatically import presets created in PhotoFrame 4. User 
added frames will need to be manually added to PhotoFrame 4.5 again. 
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Uninstalling 

To uninstall PhotoFrame follow these instructions.  
 
Windows  

1. Deactivate PhotoFrame by launching it and selecting deactivate from the Help menu.  
2. Quit Photoshop.  
3. Click on the start menu and select Control Panel.  
4. Double-click on Add/Remove programs.  
5. Select PhotoFrame 4.5 and click remove.  

  
note: these instructions are for Windows XP, the steps for Windows Vista are similar.  
 
Macintosh  

1. Deactivate PhotoFrame launching it and selecting deactivate from the Help menu.  
2. Quit Photoshop  
3. Navigate to the Plug-Ins folder of your host applications. For example Applications/Adobe Photoshop CS3/Plug-Ins  
4. Locate the PhotoFrame 4.5 folder and move it to the trash  
5. Navigate to the PhotoFrame support files and frames located at Library/Application Support/onOne Software/  
6. Move the PhotoFrame 4.5 folder to the trash  
7. Navigate to the Applications folder and move the PhotoFrame 4.5 folder to the trash 

See also 

System Requirements 
Installation 
Activation and Registration 
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Activation and Registration 

PhotoFrame 4.5 will operate as a trial version for 30 days from when it is installed. If you have purchased PhotoFrame you will want to license it so you can 
continue to use it past the trial period. When you install PhotoFrame it will prompt you to license it. Simply click on the license button and enter your license 
code. Your license code can be found in your order confirmation email if you purchased PhotoFrame electronically or on a sticker on the information card in 
the boxed version. Your license code allows you to install PhotoFrame on two computers. When you enter your license code PhotoFrame communicates with 
the onOne activation server and will activate your software. Your software must be licensed and activated to function past the trial period. If the computer 
you are activating does not have access to the internet you can manually activate your software by following the manual activation instructions in the 
license dialog. 
 
If you wish to move your copy of PhotoFrame from one activated computer to new computer you will need to deactivate it first. Deactivation is a simple 
process. Simply open PhotoFrame and select deactivate from the Help menu. This will deactivate PhotoFrame on the current machine, allowing you to install 
and activate it on another machine.  
 
If you lose your activation code, have your computer stolen and can not deactivate it or have other activation issues please contact onOne customer 
service at 888-968-1468 or visit the support section of the onOne software website http://www.ononesoftware.com/support.  
 
It is important to register your copy of PhotoFrame so we can provide you with the best possible service. Registered  users of PhotoFrame are eligible for 
technical support, information regarding new versions and products, discounts and special offers on new products. 
 

See also 
System Requirements 
Installation 
Uninstalling 
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What's New in PhotoFrame 4.5 

New Features 
● NEW add as clipping mask feature allows you to tear the edge of an image in an editable, non-destructive way. 
● NEW layer controls let you place elements above and below your image layer and create clipping masks so you can create full layouts inside of 

PhotoFrame. 
● NEW design elements collections including family events, magazine covers, and several collections for children and high school senior portraits. 

 

Key Features 
 
Complete Library of Design Elements: Now, it is easier than ever to add authentic film and darkroom edge effects to your images. But PhotoFrame is 
about more than just edges and frames. It includes an extensive library of design elements including edges, frames, backgrounds, textures, adornments, 
even complete page layouts. The Library window gives you a fast way to find the perfect element and preview it with your image. 
 
PhotoFrame 4.5 includes several new collections of design elements. First is the new whimsical collection featuring fresh and bright design elements that are 
perfect for children and family layouts. Second is the new family event collection that includes elements and layouts for the special events in our lives like 
birthdays, graduation and holidays, etc. Also included is the Bohemian collection for high school seniors with a distinct, vintage look. And finally we have 
added some great backgrounds from noted photographer Kersti Malvre. Add the perfect finishing touch to your images with a library of professionally 
created edge effects and design elements that really make your images stand out. 
 
Create Full Layouts: You can create full page layouts inside of PhotoFrame 4.5. Just start with a blank canvas and your images. You can add a 
background to the page, then size and reposition your image and then add elements like frames and adornments. With the New abilities to resize your 
image layer, the ability to move elements, such as backgrounds, under the target layer and rulers and guides it has never been faster to create great 
looking albums.  If you create a layout you love, save it as a preset so you can use it again like a template. 
 
Output your way: You have the option to add design elements to the current layer, or a new layer. You can also have each frame rendered to its own 
layer so you can make further adjustments or masking in Photoshop. You can even apply a frame as a layer mask so you can selectively blend multiple 
layers together. PhotoFrame 4.5 adds the ability to output design elements as a clipping mask to the several output methods already available. Clipping 
masks are a great way to vary the shape or edge of an image layer in an editable, non-destructive fashion. (note, output options are limited in Apple 
Aperture) 
 
NEW onOne Panel: The new onOne Panel in Adobe Photoshop allows the user to quickly launch PhotoFrame without having to navigate through 
Photoshop's menus. But it takes that power even farther by giving users access to their favorite presets right from the panel as well. This will save users 
time by allowing them to apply their most frequently used effects right inside of Photoshop.
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Getting Started 
 
This getting started section will give you only the basics of using PhotoFrame. If you have never used PhotoFrame before this is a good place to start. You 
might also try watching the getting started video tutorial. For detailed information on steps and controls mentioned in the getting started section see the 
Using PhotoFrame section instead. 

 
 
Articles in this section  
Supported File Types 
Opening PhotoFrame 
Types of Design Elements 
Finding an Element 
Adjusting an Element 
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Supported File Types 

PhotoFrame 4.5 supports 8 and 16 bit RGB, Grayscale and CMYK images. This means PhotoFrame will support the majority of image types used by 
photographers and graphic artists including camera raw files. PhotoFrame functions on the information provided from the target layer, this is the layer 
selected in the layers palette in Photoshop. The target layer must be a standard pixel holding layer. PhotoFrame does not support text layers, smart object 
layers or adjustment layers. PhotoFrame does support empty layers so you can always create an empty layer above a smart object or other layer to add 
PhotoFrame to your image.  
 
PhotoFrame can apply its resulting design elements in a number of ways: Either to the current layer, a new merged layer, new layers for each element or 
as a layer mask on the current layer. These options are controled from the Options palette. PhotoFrame's preview will update automatically when you 
change these options. 
 

See also 
Opening PhotoFrame 
Types of Design Elements 
Finding an Element 
Adjusting an Element 
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Opening PhotoFrame 

 Opening PhotoFrame in Photoshop 

1. When you use PhotoFrame inside of Photoshop you need to open an image first.  
2. When you have the image you would like to work on be sure to select the layer that you would like to add an element to. Tip: if you are working on 

a page layout you can use the marquee tool in Photoshop to select a region to add a frame to.  
3. Then go to the File > Automate menu and select PhotoFrame 4.5  

Note: You can also launch PhotoFrame, its batch dialog and use presets directly from the onOne Menu or onOne Panel. 

Opening PhotoFrame in Photoshop Lightroom  

1. When you use PhotoFrame inside of Photoshop Lightroom you need to select and image or group of images to start.  
2. Then select PhotoFrame for the File > Plug-In extras menu.  
3. Then select the open button.  

Note: You can also access PhotoFrame from the Lightroom Export dialog for batch processing.  

Opening PhotoFrame in Aperture  

1. When you use PhotoFrame inside of Aperture you need to select an image first.  
2. Then select PhotoFrame 4.5 from the Images > Edit with menu.  
3. Then select the open button.  

Note: You can also access PhotoFrame from the contextual menu by right-clicking (control-clicking) on an image and selecting Edit with > PhotoFrame 4.5. 

 

See also 

Supported File Types 
Types of Design Elements 
Finding an Element 
Adjusting an Element 
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Types of Design Elements 

In PhotoFrame 4.5 there are several types of design elements that you can mix and match together to create the perfect finishing touch for your images. 
To learn how to find and use the different types of design elements watch the Design Elements video tutorial. 
 

 
Frames: If you have used previous versions of PhotoFrame you are familar with the concept of frames. 
These are edge or border treatments. Frames can look like traditional photographic film edges from 
different types of film or darkroom techniques as well as torn paper, brushed emulsion, etc. The range of 
frames in PhotoFrame is astounding. Frames are generally applied to modify the edges of an image or an 
image layer 

 

 
Backgrounds: Backgrounds are new to PhotoFrame 4.5. Backgrounds are complete images that can be 
placed on an empty layer under your image(s). Backgrounds are the often the base layer used when 
creating layouts. The backgrounds in PhotoFrame 4.5 can be details of natural or man made materials such 
as brick walls or rusted metal; or composite backgrounds created by onOne that blend several elements 
together. Backgrounds can also be used as texture overlays if they are added on top of an image and their 
opacity and blending modes are altered.

 

 
Textures: The idea of textures has been changed significantly in PhotoFrame 4.5. In previous versions of 
PhotoFrame textures where applied only to frames, limiting their usefullness. In PhotoFrame 4.5 textures 
work just like frames or other elements. They can be applied on top of an image to alter the surface of the 
image. Changing the background color will control the color of the texture. It is often best to alter the 
opacity and blending mode of textures to make them blend realistically into your image. The soft-light 
blending mode is a great place to start. The textures in PhotoFrame 4.5 can simulate different artistic 
mediums like watercolor paper and canvas as well as scratched film and even text overlays. A good tip to 
remember when adding a texture is to use the apply each frame to a new layer option in the Options 
Palette. This will add a mask to the layers so you can easily paint the texture off your subject.
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See also 

Supported File Types 
Opening PhotoFrame 
Finding an Element 
Adjusting an Element 

 
Adornments: Adornments are also new to PhotoFrame 4.5. Adornments are graphically interesting 
illustration style elements that can be used as textures to break up an image edge or background. 
Adornments can also be "holders" such as tape, photo corners or thumbtacks that can be used to "hold" an 
image or element to the background.

 

 
Layouts: Layouts combine all of the design element types into complete layouts that can be applied just like 
a frame. Layouts feature a composite background with a frame and adorments floating on top of it. You 
can create your own layouts in PhotoFrame by combining multiple elements. These layouts can give you an 
idea of what's possible as well as give you a quick way to get started with PhotoFrame.
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Finding an Element 

 

See also 

Supported File Types 
Opening PhotoFrame 
Types of Design Elements 
Adjusting an Element 

 
When PhotoFrame opens you will see the Library window. The Library contains all of the 
different design elements such as frames, backgrounds, textures, adornments and layouts. 

 

 
On the left side is a list of categories. You can browse the categories and see the elements in 
each category in the thumbnail section on the right

 

There is also a search field where you can simply type in what you are looking for. 

 

You can browse through the thumbnails by scrolling up and down. You can zoom in by 
adjusting the size of the thumbnails with the size slider.

 

You can also browse through presets the same way, simply click on the preset tab in the 
upper left corner.   

Once you find an element you are interested in simply double-click on it to add it to your 
frame stack. When you add a frame to your frame stack the Library will close and you will 
see the main preview window. 
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Adjusting an Element 

 

  

Once you have added a element to your image you will probably want to adjust it. Start 
by adjusting the background color. The background color is usually the color overlay 
outside of a frame. If you have added an adornment or a texture the background color 
will often be the color of the element. For some element types you may want to select 
transparent if you want to background color. You can adjust the background color and 
options in the background palette by opening the color selector. In the color selector you 
can select a color by clicking in the color array, typing in RGB color values or by clicking on 
the Photoshop color picker option to use the standard Photoshop color dialog. You can 
also adjust the opacity and blending mode of an element to have it blend into your image 
in a more realistic way. 

 
  

Next you will want to adjust the size and position of the element. You can do this with the 
size slider in the background palette or by moving your mouse over the preview area you 
will see corner handles appear on the edges of the element. You can then click and drag to 
change the size, rotation and position of the element. Sometimes you might want to adjust 
the size and position of the image under the element as well. You can do this by selecting 
the image layer at the bottom of the frame stack and then using the same size and 
position options 

 
   
You can then try adjusting some of the other options in the border, glow and shadow 
palettes if you like. You can also open the Library again to either add another element to 
your frame stack or to replace your current element. 

 
   
Once you are happy with your creation you can apply it your image and send it back to 
Photoshop. First, be sure to check your Options palette and make sure you have the 
option selected that you prefer. The default in PhotoFrame 4.5 will apply your elements as 
a new layer in Photoshop. (Keep in mind that if you are working in Photoshop Lightroom or 
Aperture that the results will always apply directly to your image) Then press the Apply 
button in the bottom right corner. Congratulations, you made your first creation with 
PhotoFrame 4.5
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See also 

Supported File Types 
Opening PhotoFrame 
Types of Design Elements 
Finding an Element 
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Getting Around the Interface 

 
 

Pages in this Section 

 

 
Library Interface 

 
Preview Interface 

 
Palette Interface 
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Library Interface 

 
 
A - Library and Presets tabs: Select which tab you would like to view. 
B - Search field: Type in keywords for elements you would like to find. 
C - Category List: Heirarchical tree view of content categories. 
D - Thumbnail (selected) 
E - Element Name 
F - Element Rating and Favorite: Click on the stars or flag to change the items rating or to make it a favorite 
G - Remove from Results button: Removes the item from the current results set. 
H - Background Color Selector: Toggles the element background color from white to black. 
J - View Frame Only: Toggles between preivewing with our image or just the frame alone. 
K - Thumbnail Size Slider: Changes the size of the thumbnails. 
L - Filter Results: Allows you to only show elements in your results that are favorites or a certain star rating. 
M - Sort Order: Changes the sort order of the results. 
N - Add/Remove Element: Plus and minus buttons to add or remove frames from the library. 
O - Add Instant: Adds an instant frame to the Frame Stack. 
P - Add Random: Replaces any elements in the Frame Stack and adds a random selection of elements. 
Q - Close Button: Closes the Library window.  
R - Apply Frame Button: Adds the selected element and then applies the Frame Stack and returns to Photoshop. 
S - Replace Frame Button: Replaces the current element in the Frame Stack with the selected element. 
T - Add Frame Button: Adds the selected element to the Frame Stack. 

 
 

See also 

Preview Interface 
Palette Interface 

 

 Tip: If you work with a large display or multiple displays you can set the Library to stay open, rather than closing automatically when you add a 
frame. Just resize the library to take up less than the full window or drag it to your second display. Then go the preferences and enable the 
"Keep Library Open" option.
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Preview Interface 

 
 
A - Rulers: Use the rulers to align elements accurately. 
B - Preview Area: This is the paste board area of the preview window. You can change it's color in the preferences. 
C - Guide: You can create a guide by clicking and dragging in the rulers. 
D - Preview Image 
E - Tool-tip bar: Displays tool-tips for the control the cursor is over. 
F - Open Library: Press this button to open the Library. 
G - Move Tool: Use this to move and resize the current element. 
H - Pan Tool: Use this to move the preview image within the preview window. 
J - Zoom Tool: Use this to zoom-in on the preview image. 
K - Cancel Button: Cancels PhotoFrame and returns to the host application. 
L - Apply Button: Applies the current Frame Stack to your image and returns to the host application. 

See also 

Library Interface 
Palette Interface 
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Palette Interface 

PhotoFrame has several control palettes. While the controls on each palette are slightly different the diagram below explains the most common elements 
that you may find on most palettes. 
 
The palettes in PhotoFrame can be nested together by dragging a palette on top of another. You can also seperate nested palettes by pulling them apart. 
Simply click and drag a palette tab away from the main palette to unnest it. PhotoFrame will remember your palette options and locations automatically. 
 

 

Learn more about each Palette here 
Frame Stack Palette 
Adding an Instant Frame 
Options Palette 
Background Palette 
Border Palette 
Glow Palette 
Shadow Palette 
Edge Palette 
Bevel Palette 
 
See also 

Library Interface 
Preview Interface 

A - Palette Tab: Click and drag to move or nest palettes 
B - Blending Mode: This changes the Blending Mode of the element that the palette controls 
C - Opacity: This changes the opacity of the element that the palette controls 
D - Color: Click to bring up the color picker to change the element color 
E - Eye Dropper: Select the dropper and click on a color in the preview image to change the elements 
color to match 
F - Reset: Press this button to reset the palette options to the defaults
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Articles in this section 

See also 
Welcome 
Installation 
What's New in PhotoFrame 4.5 
Getting Started 
Getting Around the Interface 
Menus 
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Using the Library 

 

 

 
 

See also 

 

  
The Library is the heart of PhotoFrame 4.5. It contains all the design elements that you 
will work with in PhotoFrame. It is the first thing you see when you open PhotoFrame. The 
library helps you perform several important tasks on the way to finding the perfect design 
element or preset. 

● Browse through the content categories  
● Search for content based on descriptive keywords  
● Mark content as favorites or rate them  
● Preview what an element will look like on your image  
● Add or remove frames from the database  
● Narrow your results by removing elements you are not interested in  
● Add, Replace or Apply an element to your image 

 

Opening the Library 
Browsing Categories 
Searching 
View Options 
Narrowing your Selection 
Ratings and Favorites 
Adding an Element to the stack 
Personal Elements 
Presets 
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Opening the Library 

When you launch PhotoFrame you should see the Library immediately. This is the starting point for using PhotoFrame. When you add an element the 
Library will automatically close, revealing the preview window. To open the Library again so you can add another element or replace the current one you 
can: 

● Press the Open Library button in the bottom toolbar  
● Go the Window Menu and select View Frame Library  
● Use the keyboard short-cut (command-F for Mac OSX, control-F for Windows) 

If you have a large display or a second display you can set the Library window to stay open all the time. To do this go the preferences and select Keep 
Library Open. Then drag the Library to an open space or your second display. PhotoFrame will remember the size and location of the Library between 
sessions. 
 

See also 

Browsing Categories 
Searching 
View Options 
Narrowing your Selection 
Ratings and Favorites 
Adding an Element to the stack 
Personal Elements 
Presets 

 
 

  
26 . Using PhotoFrame

 
  

  
PhotoFrame 4.5 User Guide



Home > Using PhotoFrame > Using the Library > Browsing Categories 

Browsing Categories 

 
 

See also 

Opening the Library 
Searching 
View Options 
Narrowing your Selection 
Ratings and Favorites 
Adding an Element to the stack 
Personal Elements 
Presets 

 On the left side of the Library window is the category pane. This column contains a tree style view 
of the categories in PhotoFrame. At the very top is a special category called All Items which will 
display every design element. Below that are the main categories, which are large groups such as 
Adornments, Backgrounds, Gurus, etc. Inside of each main category are sub-categories and even 
some sub-categories have even more categories inside of them. 
 
You can open and close and category by clicking on the triangle next to the name of the category. 

● A triangle that points the the right is a closed category  
● A triangle that points down is an open category 

As you open a category deeper the sub-category names will indent. 

 

  
To the right you can see that the Photographic category is open, exposing several sub-categories. 
Also the sub-categories Film and 35mm are opened exposing Clean, Cool, etc. The category list in 
PhotoFrame makes it easy to browse through the content in a logical, folder structure style.  
 
When you click on a category it will display its contents as thumbnails in the thumbnail section. The 
contents of all its sub-categories will displayed as well. 

 

 
  

  
Using PhotoFrame . 27

 
 

  
PhotoFrame 4.5 User Guide



Home > Using PhotoFrame > Using the Library > Searching 

Searching 

 
 
 

See also 

Opening the Library 
Browsing Categories 
View Options 
Narrowing your Selection 
Ratings and Favorites 
Adding an Element to the stack 
Personal Elements 
Presets 

 At the top of the category list is a search field. You can type in descriptive words, or "keywords" into 
the search field to help content you are looking for. The results of your search appear in the 
thumbnails area. The search field responds as you type each letter into it. For example if you start 
by pressing "k" the results in the thumbnails section will automatically be created with elements that 
start with k. As you type each subsequent letter the search results will narrow down. 
 
Here are some guidelines to help you get the best results when using the search field: 

● The search field searches the names of the elements, not the category names. However 
most element names start with a category name. For example if you type in adornment, you 
will find and element who's name begins with adornment.  

● The Library uses a "starts with" type of search. This means if you typed in a search for "low" 
it would find elements named lower but not flower.  

● Depending on the speed of your computer it may take a second or two for your results to 
appear.  

● The search field always searches every element in the Library not just the category or 
search results that you already have.  

● You can clear the search field completely by pressing the reset button. 
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View Options 

Using the Library is similar to using an image browser like Photoshop Lightroom or Bridge. It shares some common controls for adjusting the thumbnail view 
as well as some special controls just for PhotoFrame. See the sections below to learn how the view controls work. 
 

 
Articles in this section 

 

 

 Note: Composite view is not enabled in the Library thumbnail section. You will see only your target layer under the frames or design 
elements. If you have an empty layer or a layer with lots of transparency you will see the transparent checkerboard.

View Background Color 
Show Frame Only 
Thumbnail Size 
Filtering 
Sorting 
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View Background Color 

 

 

See also 

Show Frame Only 
Thumbnail Size 
Filtering 
Sorting 

 The Frame Background color selector will toggle between white or black. This refers to the color of the 
"background" region of the frame. This is the same as setting the color in the background palette. Toggling 
from white to black may make it easier to preview some design elements such as adornments. 
 
The color you have selected is the color that the background of your frame will be when you add it to your 
stack.  
 
You can also select the Transparent if realistic frame option, which will set the background color to none if the 
frame is a realistic frame, like a layout or most adornments. 

 

   
 White Frame Background  Black Frame Background
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Show Frame Only 

 

 
 

See also 

View Background Color 
Thumbnail Size 
Filtering 
Sorting 

 Normally when you use the Library it shows your image underneith the different frames and design elements. You can turn this off 
by changing the the Show Frame Only toggle. When it is enabled you will see the just the frame or design element only. This can be 
helpful when browsing adornments.  

   
 Normal View  Show Frame Only
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Thumbnail Size 

 

 

See also 

View Background Color 
Show Frame Only 
Filtering 
Sorting 

You can change the size of the thumbnails by using the Thumbnail Size slider. There are five settings, ranging from a 
single thumbnail to a matrix of 5x5 at a time.  

 

 

 Note: Depending on the size of your display, the speed of your computer and the size of your image it may take a second or two to change 
thumbnail sizes. Larger thumbnails will scroll slower than smaller thumbnails will.
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Filtering 

 
 

See also 

View Background Color 
Show Frame Only 
Thumbnail Size 
Sorting 

 The Filter Results option allows you to remove any thumbnails that do not match the filter criteria. You can turn the filters 
on by clicking on any of the stars or the favorite flag. 

● When the favorite flag is on (orange) only elements that are marked as favorites will appear in the thumbnails  
● When the rating stars are turned on (red) only elements matching that star rating will be appear in the 

thumbnails. 
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Sorting 

 
 

See also 

View Background Color 
Show Frame Only 
Thumbnail Size 
Filtering 

 The Sort Oder pop-up lets you control how the thumbnails sort. You can sort them alphabetically, which is the default or you can 
sort favorites first or by rating. 

● Favorites First: Elements marked with the favorite flag will be at the top of the list alphabetically, followed by non-
favorites also alphabetically.  

● Rating: Elements with the highest rating (5 stars) will be be listed first followed by 4 stars, 3 stars etc. Within each group 
the elements will be sorted alphabetically too. 
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Narrowing your Selection 

 
 

See also 

Opening the Library 
Browsing Categories 
Searching 
View Options 
Ratings and Favorites 
Adding an Element to the stack 
Personal Elements 
Presets 

 The thumbnail area of the Library works like a light-table view in an 
image browser. You can use the thumbnail view to select multiple 
frames and elements and perform tasks such as removing them from 
the current view, adding to the Frame Stack or deleting them from 
the PhotoFrame database. 
 
You can tell if an element is selected by the gray rounded rectangle 
surrounding it. For example the center image in the illustration to the 
right is selected while the other elements are deselected. You can 
select multiple frames by: 

● Cmd-clicking (Mac) Ctrl-clicking (Win) to add individual frames 
to your selection  

● Shift-clicking to add a continious range of frames to your 
selection.  

● Selecting all frames using the Select All command from the 
Edit menu. 

In the edit menu you will also find commands to invert your selection 
or deselect all frames. 
 
You can remove the selected frames from your current view by 
clicking the small "X" icon in the bottom right corner of any selected 
element thumbnail. This does not remove the elements from 
PhotoFrame, it just hides them temporarily making it easier to narrow 
down your thumbnails until you find the element you are looking for.  

 
  

  
Using PhotoFrame . 35

 
 

  
PhotoFrame 4.5 User Guide



Home > Using PhotoFrame > Using the Library > Ratings and Favorites 

Ratings and Favorites 

 
 

See also 

Opening the Library 
Browsing Categories 
Searching 
View Options 
Narrowing your Selection 
Adding an Element to the stack 
Personal Elements 
Presets 

  
Under seach thumbnail in the Library are icons for adjusting the favorite status or rating of an element. 
Simply click on the icons to turn them on or off. 

● Favorite Flag: Marking an element as a favorite makes it easier to find. You can use the filter 
option to only show your favorites quickly. Your favorites will also appear in a special category in 
PhotoFrame for Photoshop Lightroom or PhotoFrame for Aperture.  

● Rating Stars: Ratings are another way to mark elements to make them easier to find. Simply click 
on a star to set its rating. Clicking on the same star again will turn the rating off for the item. If 
you want to change the rating, just click on the appropriate star 
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Adding an Element to the stack 

Adding an element from the Library to the Frame Stack is simply: 
 

● Double-click to add the selected element to the current position in the Frame Stack  
● Press the Add Frame button to add the selected element to the current position in the Frame Stack  
● Press the Replace Frame button to replace the currently selected element in the Frame Stack with the element selected in the Library  
● Press the Apply Frame button to add the selected element to the current position in the Frame Stack and apply the Frame Stack and return to the 

host application (Photoshop) 

 

See also 

Opening the Library 
Browsing Categories 
Searching 
View Options 
Narrowing your Selection 
Ratings and Favorites 
Personal Elements 
Presets 
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Personal Elements 

You can easily add your own custom frames or design elements as well as frames and elements from the onOne website or onOne Exchange. Follow the 
instructions on the following pages to learn how to create and manage your own custom elements. 
 

Pages in this Section 

 
Creating Elements 
Adding Elements 
Finding Elements Online 
Deleting Elements 
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Creating Elements 

Users can create their own design elements and add them to PhotoFrame. A good example would be converting your logo to a design element so you can 
easily add it to an image. Follow the steps below for creating your own basic element from a logo or signature file. This technique will create single colored 
element and you can control the color from the background palette. 
 

Now add the logo file using the instructions on the Adding Elements page. You can also create your own basic frames using this same technique. Just make 
sure the inner area of the frame, where the image should go remains white and the outer edge is black. 
 

Creating RGB Elements 
 
Creating RGB elements, also known as realistic frames is a bit more complicated. Each RGB element consists of three files:  

● The frame image, the regular RGB pixels  
● Inner mask , a grayscale mask that masks the inner area of the frame  
● Outer mask, a grayscale mask that masks the outer area of the frame 

 

 Open your logo in Photoshop

 

 Convert your logo to grayscale by selecting File > Mode > Grayscale

   Make sure your logo is black on a white or transparent background. You may 
need to increase the contrast to achieve this.

 

 Save your logo as a JPG file with a .frm extension
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When you add RGB frames only one entry will be added to the PhotoFrame database, not three, but you need to add all three files at the same time. If you 
which to add your own RGB background elements follow the steps above but make the inner and outer mask files completely black. If you which to create 
RGB adornments set the fri file to completly black and the from to black with white masks for the adornment. 
 
 
See also 

Adding Elements 
Finding Elements Online 
Deleting Elements 

 

Frame image 
the regular RGB pixels. The area inside and outside the frame should be white or 
transparent. Save this file as an RGB JPG with a .frr extension. It is important that the 
main file name is the same for all three elements, for example myframe.frr

 

Inner mask  
A grayscale mask that masks the inner area of the frame. The area inside the frame, the 
hole where the image should go, should be white. The rest of the image should be black. 
Save this file as a grayscale JPG with a .fri extension. It is important that the main file 
name is the same for all three elements, for example myframe.fri

 

  
Outer mask 
A grayscale mask that masks the outer area of the frame. The area outside of the frame, 
think of it as the background, should be white. The rest of the image should be black. 
Save this file as a grayscale JPG with a .fro extension. It is important that the main file 
name is the same for all three elements, for example myframe.fro
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Adding Elements 

Adding your own design elements to PhotoFrame is easy. Before you add them, make sure they are compatible by checking the Creating Elements page. 
Then follow these steps to add your own elements: 

1. Open PhotoFrame  
2. In the Library, press the plus icon at the bottom of the category list  
3. An Open dialog will appear, navigate to your custom design elements  
4. Press Open 

When you add elements to PhotoFrame they will be copied into the PhotoFrame database and will be placed in a category labeled "User Frames." If you are 
adding elements that you downloaded from the onOne website they will be automatically placed in new categories based on the frame names. 
 

 
 
 

See also 

Creating Elements 
Finding Elements Online 
Deleting Elements 

 

 Note: If you have several frames to add, just place them in the same folder and then select the folder from the Open dialog.
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Finding Elements Online 

If you have used a previous version of PhotoFrame you have probably noticed that many of the old frames are not installed with PhotoFrame 4.5. From 
customer feedback we have learned that many of these frames are not used. In PhotoFrame we only left in the most popular frames to make room for the 
new types of content. You stll have access to the old frames if you like. Just click on the Find Frames Online command in the Frames menu or visit the 
support section of the onOne website for details on how to find the old frames and download them. To install them see the Adding Elements page. 
 
You can also find user-created frames and presets located at the onOne Exchange, an online community of onOne customers. You can also share your 
custom made frames and presets here as well. 

See also 

Creating Elements 
Adding Elements 
Deleting Elements 
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Deleting Elements 

You can remove elements from the PhotoFrame database if you no longer want to have access to this element. To remove an element follow these steps: 

1. Open PhotoFrame  
2. Select the element(s) you wish to remove in the Library  
3. Press the minus icon at the bottom of the category list 

See also 

Creating Elements 
Adding Elements 
Finding Elements Online 

 

 Note: Deleting elements removes them from your hard drive and you will no longer be able to use them. If you need to reload an element 
you deleted, reinstall PhotoFrame
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Presets 

Presets are at the heart of using PhotoFrame effectively in your workflow. Presets store the contents of your Frame Stack as well as the settings including 
size, position and color options for each element. Using a preset helps you reproduce your favorite looks quickly. Presets are also accessible from the 
onOne menu, the PhotoFrame batch dialog and the PhotoFrame for Photoshop Lightroom and PhotoFrame for Aperture dialogs. 
 
You can also share your presets with other users of PhotoFrame. This could be as simple as placing them on your computers in your studio so your staff has 
access to them. Or you could share them online for other users of PhotoFrame on the onOne Exchange. 
 

Pages in this Section 

 
Browsing Presets 
Using Presets 
Saving Presets 
Deleting Presets 
Sharing Presets 
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Browsing Presets 

 
 

See also 

Using Presets 
Saving Presets 
Deleting Presets 
Sharing Presets 

 
Finding and browsing presets is just like finding 
and browsing any other type of content in 
PhotoFrame. Start by opening the Library and 
then click on the Presets tab in the upper left 
corner. The window will look similar to the normal 
Library view. The category list will change to 
your preset categories and the thumbnails will 
show the stored thumbnail in the preset rather 
than your image. You can use the same search 
and view options as you would in the normal 
Library. 
 
You won't see your image in thumbnail section, 
however you will see a thumbnail of what a 
preset looks like with the image that it was 
created with. 
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Using Presets 

You can load or apply a preset from several locations in PhotoFrame, first from the Preset tab of the Library you may press either the load or apply buttons 
at the bottom of the Library window. 

● Load Preset: Clears the current Frame Stack and then loads the preset into it.  
● Apply Preset: Clears the current Frame Stack and then loads the preset into it, then applies it and returns to the host application. 

You can also apply presets directly from the onOne menu, the PhotFrame Batch dialog or the PhotoFrame for Photoshop Lightroom or PhotoFrame for 
Aperture dialogs. 

See also 

Browsing Presets 
Saving Presets 
Deleting Presets 
Sharing Presets 

 
When you load a preset into the Frame Stack it will replace any elements already in it. It will 
also lock multiple elements together so you move and resize them together at once. You can 
identifly locked elements by the link icon between element layers. You can click on this icon to 
turn the link off between layers if you need to.
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Saving Presets 

 
 

See also 

Browsing Presets 
Using Presets 
Deleting Presets 
Sharing Presets 

Saving a preset is simple. Once you have a Frame stack that you wish to save, 
go to the File menu and select Save Preset. 
 
The New Preset dialog will appear (shown to the right). There are several fields 
to complete including the preset name, the category, creator and description. 
 
In the category pop-up you can select which category the preset is saved into. 
You can also create a new category this way as well be selecting new category 
from the bottom of the list.
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Deleting Presets 

You can remove a preset from the PhotoFrame database if you no longer want to have access to it. To remove a preset follow these steps: 

1. Open PhotoFrame  
2. Select the preset(s) you wish to remove in the Library  
3. Press the minus icon at the bottom of the category list 

See also 

Browsing Presets 
Using Presets 
Saving Presets 
Sharing Presets 

 

 Note: Deleting elements removes them from your hard drive and you will no longer be able to use them. If you need to reload an element 
you deleted, reinstall PhotoFrame

 
 

  
48 . Using PhotoFrame

 
  

  
PhotoFrame 4.5 User Guide



Home > Using PhotoFrame > Using the Library > Presets > Sharing Presets 

Sharing Presets 

You can share your presets with other users of PhotoFrame. Follow these steps: 

● Open PhotoFrame  
● Go to File > Open Presets folder 

A Finder (Mac) or Explorer (Win) window will open and will display the presets folder. In the presets folder are sub folders for your preset categories. Inside 
each sub-folder are the individual preset files, with a .pto extension. You can copy these presets files to the same location on other machines with 
PhotoFrame to share them. 
 
You can also post them on the onOne Exchange site to share them with other PhotoFrame users. If you find a preset that you like on the onOne Exchange 
you can load it into PhotoFrame by placing it in your preset folder and then re-opening PhotoFrame. 
 

See also 

Browsing Presets 
Using Presets 
Saving Presets 
Deleting Presets 

 

 Note: PhotoFrame loads its presets from the the presets folder when it is opened. If you add a preset while PhotoFrame is open you may 
not see it until you re-open PhotoFrame.
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Using the Preview Window 

 
 

] 

 

 
Navigating the 

Preview 

 
Move Tool 

 
Rulers 

 
Guides 

 
Composite View 
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Navigating the Preview 

PhotoFrame provides a number of easy ways to navigate and view your image in the Preview window.  
 

Hand Tool  
The Hand tool is used to drag the image within the Preview window, whenever the image size is larger than the viewable area.  
 
 
To pan (scroll) in the Preview screen:  

● Select the Hand tool and drag the image until you locate the area you wish to view.   
● With any other tool selected press Spacebar while you drag the image in the window. 

 

Zoom Tool 
The Zoom tool changes the magnification of the image in the Preview screen from 1% to 1600%.  
 
With the Zoom tool selected:  

● Click in the Preview window to zoom in and center the image at the location clicked.  
● Click and drag in the Preview screen to draw a rectangular marquee—the screen fills with the area within the marquee when you release the 

mouse.  
● Double-click in the Preview screen to set the Preview screen to 100% magnification.  
● Hold the Option key (Mac) or Alt key (Win) and click to zoom out (cursor changes to a minus sign).  

See also 

Move Tool 
Rulers 
Guides 
Composite View 

 

Tip: Hold down the spacebar temporarily to activate the Hand tool no matter what tool is currently selected 
 
Tip: Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

 

 Tip: Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when adjusting 
textures and for examining small details.
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Move Tool 

 

 

See also 

Navigating the Preview 
Rulers 
Guides 
Composite View 

Use the Move tool to resize, reshape, and reposition the element on the image. When the cursor is positioned inside 
the Preview window and the Move tool is selected, a wireframe with eight handles, or hot spots, along the perimeter 
of the frame is displayed. These perimeter handles allow you to resize the element on the image. Two other hot 
spots, one inside the wireframe box and the other outside it, allow you to position and rotate the frame.As you pass 
the Move tool over the ten hot spots, the cursor changes shape to indicate the type of movement that will be applied 
when you click and drag from that spot.  
 

● The side handles (top, bottom, left, right) resize the element from their respective side in any direction. 
Using the side handles will change the proportions of the element.  

● The corner handles resize the image from their respective corner in any direction. Resizing with the corner 
handles will maintain the aspect ratio of the element/image.   

● The outside pointer allows you to rotate the frame. Simply position the move tool near a corner. When the 
cursor changes to the rotate cursor click and drag to rotate.  

● Clicking and dragging inside the box will allow you to change the position of the element. 

 

Tip: You can use the Move tool to resize and reposition the image layer. Just select it at the bottom the Frame Stack and then use the Move Tool 
just like you would with any other element.

 

 Tip: You can move the currently selected element in small amounts by using the arrow keys on your keyboard.

 

Tip: The Background palette also contains frame size adjustment and rotation controls, along with Flip Horizontal and Flip Vertical buttons.
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Rulers 

 
 

See also 

Navigating the Preview 
Move Tool 
Guides 
Composite View 

 The rulers are a new addition to PhotoFrame. They help you to 
precisely position elements in relation to the entire image area. 
 
To turn the rulers on: 
• Go the the View menu and select Show Rulers 
• Or use the cmd+R (Mac) ctrl+R (Win) shortcut 
 
You can change the ruler units by: 
• Right clicking on the rulers and selecting the units  from the the pop-
up  menu 
• Or by changing them in the preferences 
 
By default the origin point for the rulers is the upper left corner of the 
image layer. You can change the orgin point by clicking and dragging 
from where the rulers intersect in the upper left corner of the 
Preview window to a new location. Gray guides will appear while you 
do this to help identify the exact location. You can reset the origin 
point to the default location by double-clicking in the intersection of 
the rulers. 
 
You can also set the rulers to be centering rules by go the the 
preferences and enabling this option. This is useful for centering an 
element or the image layer within the image area. 
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See also 

Navigating the Preview 
Move Tool 
Rulers 
Composite View 

 Guides are new to PhotoFrame 4.5. They allow you to place arbitrary 
guide lines that may be used for alignment. To use the guides you 
need to have the rulers turned on.  
 
To add a guide: 
• Make sure the Move tool is selected, then click in a ruler and drag 
into the image. 
 
To move a guide: 
• Make sure the Move tool is selected, then hover over a guide until 
the cursor changes to opposing arrows. Then click and drag on the 
guide to change its position. 
 
To remove a guide: 
• Removing a guide is just like moving a guide, just move the guide 
back to a ruler to remove it. You can clear all the guides at once by 
going to View and selecting clear guides. 
 
You may hide/show the guides by going to the view menu and 
selecting Show/Hide Guides. 
 
You can change the color of the guides in the preferences dialog.
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Composite View 

With the View Composite Layer feature you can see all visible layers of your Photoshop image in PhotoFrame, not just the layer you are working on. This 
allows you to see your effects in relation to the rest of the image or layout without having to flatten the layers.  
 
To view multiple image layers from Photoshop in PhotoFrame:  
 

1. In Photoshop, verify that all the layers you want to see in the image preview area have been made visible (eye icon showing in the layers palette).  
2. Select the image area that you want to work on. (if you select nothing PhotoFrame will work with the entire layer)   
3. Open PhotoFrame. In the PhotoFrame Preview screen you should see all the layers along with the frame layer you will be working on.  
4. If you do not see the layers along with your image, choose View > View Composite Layer. This enables the View Composite Layer function in case it 

has been turned off. View Composite Layer is on my default. 

 

 

See also 

Navigating the Preview 
Move Tool 
Rulers 
Guides 

 

 Tip: You can toggle the View Composit Layer feature on and off by pressing Cmd+L (Mac) or Ctrl+L (Win). 
 
Tip: Your preview in PhotoFrame may change based on your Options palette settings. Be sure to set it to your preference before pressing 
apply.

 

 Note: The Composite View Feature only works in the Preview Window, not in the Library. In the Library you will only see your currently 
selected layer. If your current layer is empty or contains transparency you will see the checkerboard pattern behind each element in the 
Library.
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 In PhotoFrame, each element you add to the image creates a separate" layer". These 
layers are displayed in the Frame Stack palette.  
 
PhotoFrame layers work very much like Photoshop layers: you can show or hide element 
layers, shuffle the order so that an element will mask or be masked by other elements, 
add and delete layers, and apply effects to one layer without affecting the others.  
 
To show or hide an element layer:  
• Click the Eye icon for the desired element.  
 
To reorder elements on the element Layers list:  
• Select the element to be moved, then drag it up or down the list and release at the new 
location.  
 
To remove a layer:  
• On the element Layers list, select the element to be removed, then click the minus icon 
located below the list.  
 
To add another element to the Frame Stack: 
• Click on the plus button to open the Library. If the Library is already open you can select 
an element and press the Add Frame button or just double click on the frame thumbnail. 
 
To link layers together: 
• Click on the empty box between layers to link the two adjacent layers together. This 
allows you to size and move multiple layers in unison. 
 
Save Preset: This button will open the save preset dialog where you can save the current 
stack as a preset so you can use it again easily. 
 
Add Instant: This button will add an instant frame and will open the Instant Frame palette 
if it is not open. 
 
Add Random: This button will clear the current stack and and add a random group of 
elements. See Adding a Random Frame. 
 
At the bottom of the Frame Stack is the image layer that you selected in Photoshop. You 
can select the image layer and use the move tool or the size and orientation tools in the 
Background palette to resize and reposition the image to fit a thick frame better. This is 
useful for the layout series. You can also drag design elements under the background, or 
target layer as well. This is useful if you wish to place a background behind a floating 
layer. 

 

 

 Tip: You can clear all the elements from the Frame Stack at once by option (Mac) alt (Win) clicking on the minus icon.
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 PhotoFrame has the ability to add a random group of frames and other elements to your 
Frame Stack. This is a great way to experiment in PhotoFrame and see a wide variety of 
options very quickly. To add a random frame Click the Add Random button in either the 
Frame Stack or the Library.  
 
Your current stack will be replaced with a random group of frames based on your 
Randomizer Options set in the preferences dialog.

 
 
 You can control the results of the random frame generator in the preferences dialog. 
Below are the options and what they control: 

● Color: Sets the color range that can be applied to an element. O is black and white 
is 255. If you want your random frame to be dark try a range from 0-100, if you 
want a light frame try 150-255.  

● Blur: Sets the range of blur that may be added to the background of each 
element.  

● Size: Sets the size range potential for each element. If you want to minimize the 
amount of your image that is covered try setting the values to 10 and 20.  

● Opacity: Sets the opacity range that may be used on each element. Using low 
opacity options will make the overall frame semi-transparent.  

● Noise: Sets the range of noise (grain) that may be added to the background of 
each element.  

● Orientation: Sets the rotation range that may be used on an element. Keep this 
set at zero if you prefer no rotation.  

● Frames: Sets the number of frames or elements that may be added. If you prefer 
only a single frame set both values to one.  

● Monochromatic: When enabled this will set the background color of each element 
to be shades of gray, rather than colors.  

● Random Flip: These options enable the random horizontal and vertical flipping of 
frames.  

● Include Realistic Frames: When enabled this option will use realistic frames like the 
film series as well as backgrounds in the random mix.  

● Use All Records: When enabled this option will select frames and elements at 
random from the entire library rather than your current search results. If you are 
trying to apply a random frame from a specific category be sure to turn this option 
off.  

● Random Blend Modes: When enabled this option will randomly change the blending 
mode of each element added. This can create a more translucent look for your 
finished frame. 

 

 

 Tip: If you create a random frame that you like save it as a preset so you can use it again. Just click on the Save Preset button in the Frame 
Stack palette.
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Tip: If you like part of the results that the random frame generator creates you can always go to the Frame Stack and remove or alter the 
frames to customize the results.

 

 Note: When you click on the random frame button it will remove any elements currently in your Frame Stack.

Note: If you have the Include Realistic Frames and Use All Records options both turned off and your search results contain only realistic 
frames the Add Random frame button will not add any frames to your stack.
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Adding an Instant Frame 

 

Instant Frame allows you to create a custom frame from a basic shape. Each shape provides different 
Shaping Controls giving a wide range of flexibility in creating both common and unusual shapes. Instant 
Frames are a great way to create simple keyline frames as well as vignettes, mattes or color overlays. 
Instant Frames can be controlled with the Background, Border, Glow, Shadow, Edge and Bevel palettes 
just like any other element.The following shapes are available and described below:  
 

● Ellipse  
● Rectangle  
● Polygon  
● Star  
● Arrow  
● Heart 

To create an Instant Frame:  

1. Go to the Frame Stack palette  
2. Click the “Add Instant” button. A new frame layer is added to the Layers Stack, and the Instant 

Frame palette is acivated.  
3. From the shape pop-up menu on the Instant Frame  

palette, select the shape that you want to use.  

The shape’s default settings will automatically be selected. You can manipulate the shape using the 
shaping controls provided for that shape.  The Instant Frame palette allows you to modify or change the 
shape of an existing Instant Frame layer. 

 

 

Ellipse 

● Shape Preview: Displays a thumbnail preview of the selected shape. Shows the impact of 
changes using the shaping controls for the selected shape.  

● Shape Selection: Allows you to choose and change shapes.  
● Aspect Ratio: Varies the width of the ellipse, allowing you to create ovals.  
● Constrain Proportion: When checked, constrains proportions. When unchecked, the shape 

expands to fit the image. Watch the image on the PhotoFrame Preview screen to see the effect 
of this option.  

 

Rectangle  

● Shape Preview: Displays a thumbnail preview of the selected shape. Shows the impact of 
changes using the shaping controls for the selected shape.  

● Shape Selection: Allows you to choose and change shapes.  
● Concaved: When checked, makes the corners of the shape concaved.  
● Corner: Allows you to curve the corners of the shape from 0 to 100%.  
● Constrain Proportion: When checked, constrains proportions. When unchecked, the shape 

expands to fit the image. Watch the image on the PhotoFrame Preview screen to see the effect 
of this option. 
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 Polygon 

● Shape Preview: Displays a thumbnail preview of the selected shape. Shows the impact of 
changes using the shaping controls for the selected shape.  

● Shape Selection: Allows you to choose and change shapes.  
● Concaved: When checked, makes the corners of the shape concaved.  
● Number of Sides: Determines how many sides/corners the shape will have.  
● Constrain Proportion: When checked, constrains proportions. When unchecked, the shape 

expands to fit the image. Watch the image on the PhotoFrame Preview screen to see the effect 
of this option.  

● Corner Radius: Allows you to curve the corners of the shape from 0 to 100%. 

 

Star  

● Shape Preview: Displays a thumbnail preview of the selected shape. Shows the impact of 
changes using the shaping controls for the selected shape.  

● Shape Selection: Allows you to choose and change shapes.  
● Inset: Allows you to set the depth of the corners. A value of 0 indicates maximum depth; a value 

of 100% indicates minimum depth.  
● Number of Points: Determines how many sides/corners the shape will have.  
● Constrain Proportion: When checked, constrains proportions. When unchecked, the shape 

expands to fit the image. Watch the image on the PhotoFrame Preview screen to see the effect 
of this option.  

● Corner Radius: Allows you to curve the points of the shape. A value of 0% indicates pointy 
points; a value of 100% indicates maximum curvature of the points. 

 

 Arrow 

● Shape Preview: Displays a thumbnail preview of the selected shape. Shows the impact of 
changes using the shaping controls for the selected shape.  

● Shape Selection: Allows you to choose and change shapes.  
● Arrowhead Width: Allows you to set the size of the arrowhead.  
● Arrow Base Width: Allows you to set the width of the arrow base, or tail.  
● Constrain Proportion: When checked, constrains proportions. When unchecked, the shape 

expands to fit the image. Watch the image on the PhotoFrame Preview screen to see the effect 
of this option.  

● Corner Radius: Allows you to curve all the points of the arrow. A value of 0% represents the 
minimum curvature, yielding a pointed arrow. A value of 100% represents maximum curvature, 
yielding a rounded, keyhole type arrow. 

 

Heart  

● Shape Preview: Displays a thumbnail preview of the selected shape. Shows the impact of 
changes using the shaping controls for the selected shape.  

● Shape Selection: Allows you to choose and change shapes.  
● Broken Heart: When checked, creates a broken heart.  
● Constrain Proportion: When checked, constrains proportions. When unchecked, the shape 

expands to fit the image. Watch the image on the PhotoFrame Preview screen to see the effect 
of this option.  

● Corner Radius: Allows you to curve the corners of the heart, from 0% to 100% 

.
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 The Options palette controls how elements are applied when you press the Apply button. There are 
several options to select from. Your selection is remembered automatically from your last use of 
PhotoFrame. The preview in PhotoFrame may change depending on your selection in the Options palette. 
 

● Apply to New Layer: This option will create a new layer on top of your target layer and will merge 
all of the elements in your Frame Stack to this new layer. This is the default option in PhotoFrame 
4.5.  

● Apply Each Frame to New Layer: This option will create a new layer group and render each 
element as a new layer inside of it. This is for advanced users who would like to alter elements 
manually in Photoshop. An empty layer mask will be added to the group to allow you to mask the 
entire stack of elements at once with a black paint brush.  

● Apply to Current Layer: This option will apply the contents of the Frame Stack to the current 
layer, merging their contents. Only use this option is you want to create a torn edge look on 
your image with a transparent background.  

● Apply as Layer Mask: This will apply the contents of the Frame Stack as a black and white layer 
mask on the target layer. Keep in mind that you need to have your upper most element set to a 
black background to create an effective layer mask. Use layer mask mode if you would like to use 
an element to mask (blend) your current layer with the layers under it. 

● Apply as a Clipping Mask: This is similar to applying as a layer mask. It sends the frame(s) back to 
Photoshop as a single layer, below the target layer and creates a clipping mask. This is a handy, 
non-destructive way to tear, or modify the edge of a layer. This is very useful when working in a 
page layout environment. Note that layers placed below the target layer in PhotoFrame will be 
handled as individual layers and will not be added as a clipping mask. 

 

 
When using PhotoFrame inside of Apple Aperture, you will not see the Options palette, your results will always be applied to the current layer.  
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The Background palette allows you to work with the element background and positioning. From the 
Background palette you can select a background color, use the opacity controls to let a percentage 
of the image bleed through as the background or change the blending mode. You can vary the size 
of the element to show more or less of the background, as well as rotate the element and flip it 
horizontally or vertically. The background palette is the one you will use the most in PhotoFrame. 
 

● Blend Mode: Selections on this menu produce the same effect as when applied in 
Photoshop.  

● Color Picker: Sets the background color. See Color Picker Also allows you to set the 
background to None or Transparent.  

● Eyedropper: Allows you to extract a background color from the image. Click and drag the 
Eyedropper across the image to select a color interactively.  

● Opacity: Determines the percentage of the image that shows through the frame. Uses a 
range from 0 to 100%, where 0 represents no opacity (the background is completely 
transparent).  

● Blur: Determines how much the edge is softened. Uses a range from 0 to 99.9, where 0 
represents no edge softening.    

● Noise: Determines the amount of noise (grain) that is added to the background. Zero 
indicates no noise.  

● Size: Determines the size of the background. This works proportionally and is often a faster 
way to resize and element than to use the Move Tool and corner handles.   

● Orientation: Allows you to rotate the frame.  
● Flip Horizontal/Vertical: Click to flip the frame in the horizontal plane or the vertical plane .  
● Reset: Click to revert to the factory default settings for this palette. 

 

 

 Tip: Changing the blending mode and opacity are great ways to blend an effect into an image to make it look more realistic.  

● Try the overlay or softlight options when working with textures or adornments.  
● Try Multiply or Screen when working with Instant Film edges. 
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See also 

Using the Library 
Using the Preview Window 
Frame Stack Palette 

Color can be applied to the following frame effects/palettes:  
 

● Background  
● Border  
● Glow  
● Shadow  
● Bevel  

You can control the color used by using the color picker located in the above palettes. The color 
picker provides access to the interactive Color Palette, the current Photoshop Foreground and 
Background colors, and the Photoshop Color Picker. Color values are shown on the right side of the 
palette, in RGB. You can type in RGB values for a given color if you know them. 
 
To preview colors interactively using the Color pop-up:  

1. From the Frame Stack, select the element that you want to work with.  
2. Open the Background, Border, Glow, Shadow, or Bevel palette.  
3. Click the current-color box to open the color picker.  
4. Move the cursor over the color array on the color palette and click and drag within the array to 

observe the changes in the effect’s color on the Preview window.  
5. When you see a color that you like, press the apply button. 

• To close the color palette pop-up without changing the color, click on the cancel button. 
 
The color picker also shows the current Foreground and Background colors in Photoshop. You can click 
on either of these options to use these colors. If you need to select a color in a different color mode 
(CMYK, HSB) or a specific web color or a Pantone color select the Use Photoshop Picker option which will 
open the standard Photoshop color dialog. 
 

 
You can also select a color out of the Preview window by using the Eyedropper tool located to the right 
of the Color Picker. 
 
To preview colors interactively using the Eyedropper:  

1. From the Frame Stack, select the frame that you want to work with.  
2. Open the Background, Border, Glow, Shadow, or Bevel palette, depending on which effect’s 

color you want to work with.  
3. Select the Eyedropper tool on that palette.  
4. Click and drag the Eyedropper around in the Preview window and observe the changes in the 

effects’ color.  
5. When you see a color effect that you like, release the mouse to select that color.  

There are two options in the Color Picker labeled Transparent and None. These options are useful when 
working with multiple elements or a multiple layered file, like a layout, that contains transpareny. These 
options allow you to make the background, the area outside of an element either transparent or non-
existent. While both of these options appear similar there are a couple of differences. 
 
Transparent: The transparent option is available with any element. The transprent option will make the 
area outside of an element trasparent. If the options palette is set to Apply to Current Layer this 
option will paint away the area outside fo the element on that layer. This is the method used to "rip" 
the edge of an image. If the Options Palette is set to one of the new layer options it will leave the area 
outside of the element transparent. This is useful if you are using the border or glow effects and do not 
want a background.  
 
The None option is only available for certain elements, usually those that contain color like the tape and 
tack adornments and most of the film edges. With the none option enabled the background area is 
rendered as transparent no matter the preference in the Options palette. 
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The Border palette allows you to create a border for the selected element. Border effects are applied at 
the edge of the element where it meets the background, as either an inner or an outer border. Think of 
the border as a stroke in Photoshop. Border effects for the selected element are disabled until the 
Border palette is turned on. 

● Blend Mode: Selections on this menu produce the same effect as when applied in Photoshop.  
● Color Picker: Sets the border color. See Color Picker.  
● Eyedropper: Allows you to extract a border color from the image. Click and drag the 

Eyedropper across the image to select a color interactively.  
● Opacity: Determines the percentage of the image that shows through the border. Uses a range 

from 0 to 100%, where 0 represents no opacity (the background is completely transparent).  
● Blur: Determines how much the edge is softened. Uses a range from 0 to 99.9, where 0 

represents no edge softening.    
● Noise: Determines the amount of noise (grain) that is added to the border. Zero indicates no 

noise.  
● Width: Determines the thickness of the border.background.  
● Inner/Outer: Selects if the border is on the inner or outer edge of the element. Only one option 

can be selected.  
● Reset: Click to revert to the factory default settings for this palette.  
● On: Toggles the border effect on and off. 
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 The Glow palette allows you to work with glow effects. Glows allow you to add color or highlights that 
can either soften a look, or add bold contrasts. Glow effects for the selected frame are disabled until the 
Glow palette is turned on. 

● Blend Mode: Selections on this menu produce the same effect as when applied in Photoshop.  
● Color Picker: Sets the glow color. See Color Picker.  
● Eyedropper: Allows you to sample a color from the image. Click and drag the Eyedropper across 

the image to select a color interactively.  
● Opacity: Determines the percentage of the image that shows through the glow. You can think of 

this as a strength control. Uses a range from 0 to 100%, where 0 represents no opacity 
(the glow is completely transparent).  

● Blur: Determines how much the edge is softened. Uses a range from 0 to 99.9, where 0 
represents no edge softening.    

● Noise: Determines the amount of noise (grain) that is added to the glow. Zero indicates no noise. 
● Width: Determines the thickness of the glow.  
● Inner/Outer: Selects if the glow is on the inner or outer edge of the element. Only one option 

can be selected.  
● Reset: Click to revert to the factory default settings for this palette.  
● On: Toggles the effect on and off. 
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The Shadow palette allows you to create shadow effects for the selected frame. You can apply shadow 
effects as either inner or outer shadows, allowing you to create interesting shadow effects, including 
traditional drop shadows. Shadow effects for the selected frame are disabled until the Shadow palette is 
turned on.  

● Blend Mode: Selections on this menu produce the same effect as when applied in Photoshop.  
● Color Picker: Sets the shadow color. See Color Picker.  
● Eyedropper: Allows you to sample a color from the image. Click and drag the Eyedropper across 

the image to select a color interactively.  
● Opacity: Determines the strength of the shadow. Uses a range from 0 to 100%, where 0 

represents no opacity. Usually a value of 25%-50% looks good for shadows.  
● Blur: Determines how much the edge is softened. Uses a range from 0 to 99.9, where 0 

represents no edge softening.    
● Noise: Determines the amount of noise (grain) that is added to the shadow. Zero indicates no 

noise.  
● Offset: Controls the horizontal and vertical distance that the shadow is cast from. You can enter 

these manually or use the Manual Offset tool to drag the shadow into the position you like.  
● Inner/Outer: Selects if the shadow is on the inner or outer edge of the element. Only one option 

can be selected.  
● Reset: Click to revert to the factory default settings for this palette.  
● On: Toggles the effect on and off. 
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Edge Palette 

 
 

See also 

Using the Library 
Using the Preview Window 
Frame Stack Palette 
Adding a Random Frame 
Adding an Instant Frame 
Options Palette 
Background Palette 
Color Picker 
Border Palette 
Glow Palette 
Shadow Palette 
Bevel Palette 
Preferences 
onOne Menu and onOne Panel 
Photoshop Lightroom Use 
Aperture Use 
Batch Processing 

 The Edge palette allows you to distort the edge of your element using one of eight pre-set distortion 
types:  

● Wave  
● Triangle  
● Saw Teeth  
● Saw Teeth (Reversed)  
● Brush Strokes  
● Random  
● Diffuse  
● Clean  

You can combine different edge effects, up to four per element, and vary the height and frequency of 
the peaks.  
 

● Angle: Allows you to change the angle of the edge effect, between 180° and -180°.  
● Height: Allows you to change the depth or amplitude of the peaks in the edge effect. Uses a 

sliding scale from 1 to 50, where 1 is minimum effect and 50 is maximum effect.  
● Width: Allows you to adjust the width, or frequency of the peaks in the distortion.  
● Edge Visibility Button: Click to activate or deactivate this edge effect on the selected frame. Eye 

visible indicates that the edge effect is active.  
● Edge Type Pop-up: Displays list of basic distortions from which to choose.  
● Reset: Click to revert to the factory default settings for this palette. 
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Bevel Palette 

 
 

See also 

Using the Library 
Using the Preview Window 
Frame Stack Palette 
Adding a Random Frame 
Adding an Instant Frame 
Options Palette 
Background Palette 
Color Picker 
Border Palette 
Glow Palette 
Shadow Palette 
Edge Palette 
Preferences 
onOne Menu and onOne Panel 
Photoshop Lightroom Use 
Aperture Use 
Batch Processing 

The bevel palette allows you to add a 3D look to flat elements. It is similar to the emboss controls of 
Photoshop. It is typically used with instant frames to create mattes that look similar to what you would 
get from a frame shop. 
  
Ten pre-defined shapes on the Bevel palette provide the basis for creating any number of 3D bevel 
effects on your frames:  

● Flat  
● Round  
● Slope  
● Double  
● Half Pipe  
● Triangle  
● Ramp  
● Picture Frames 1 through 3 

To those shapes you can apply the following Surface Options:  

● Chrome  
● Heavy Metal  
● Metal  
● Plastic  
● Rubber  
● Matte 

Use the other controls on the palette to manipulate the shape and surface of the bevel to achieve just 
the look you want. Bevel effects for the selected frame are disabled until the Bevel palette is turned on.  

● Shape Selector: Determines the type of bevel.  
● Surface Options: Determines preset surface property parameters.  
● Softness: Determines how much the bevel is softened. Uses a range from 0 to 99.9, where 0 

represents no softening.  
● Width: Adjust bevel width, from 0 to 100%.  
● Height: Adjusts bevel height, from 0 to 100%.  
● Light Direction Controls: Drag the highlight knob around the sphere to adjust the direction and 

inclination of the light source, or enter absolute values in the numeric fields.  
● Highlight Background: When checked, applies highlighting effects to the background.  
● Bevel Outer: When checked, applies bevel effects to the outer edge of the image.  
● Highlight Color Selection Tools: Sets the bevel highlight color.  
● Reset: Click to revert to the factory default settings for this palette.  
● On: Toggles the effect on and off. 
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Preferences 

 
 

See also 

Using the Library 
Using the Preview Window 
Frame Stack Palette 
Adding a Random Frame 
Adding an Instant Frame 
Options Palette 
Background Palette 
Color Picker 

 The preferences dialog contains several settings that are 
remembered from session to session. They control the way 
certain features work in PhotoFrame.  
 
You can access the preferences dialog from the Photoshop 
menu (Mac) or Edit menu (Win). 
 
Enable Automatic Rotation: When enabled this feature 
will automatically rotate design elements and presets to 
match the orientation of your image. On by default. 
 
Enable Background Processing: When enabled 
PhotoFrame will work on processing the final results so that it 
will be faster when you press the apply button. On by 
default. 
 
Start with Last Used Frame Stack: When enabled 
PhotoFrame will automatically add your last used stack of 
frames each time you open it. This is the way PhotoFrame 3 
worked. Off by default. 
 
Keep Library Open: When enabled the Library will remain 
open when adding or replacing a frame in the stack. This is 
for users with a second or large display who wish to have the 
Library open all the time. Default is off. 
 
Preview Area: Click in the color pop-up to change the 
Preview window background color. 
 
Hide Host Windows: When enabled, PhotoFrame will hide 
all of Photoshop's windows while you are using it. This is on 
by default. 

Guide Color: Color pop-up allows you to change the color of 
the guides. 
 
Ruler Units: Sets the unit of measure for the rulers. This 
can also be set from the ruler contextual (right-click) menu. 
 
Centering Rulers: When enabled the rulers measure from 
the center of the image out in all directions rather than from 
the upper-left corner. Off by default. 
 
Library Location: Displays the path to the current 
PhotoFrame library. The library contains all of the frame and 
design element content and database. Depending on the 
number of frames you have installed this can take well over 
1GB of hard drive space. If you run low on hard drive space 
you can use the Move button to select a new location for the 
Library. PhotoFrame will automatically move the Library 
contents to its new location. 
 

Randomizer Options: See the Adding a Random Frame 
page for details. 
 

 

 Note: It is recommended that you leave the 
Library in its default location if possible. If 
you select an alternate location make sure it 
is fixed drive rather than a removable disc.
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onOne Menu and onOne Panel 

 
 

See also 

Using the Library 
Using the Preview Window 
Frame Stack Palette 
Adding a Random Frame 
Adding an Instant Frame 
Options Palette 
Background Palette 
Color Picker 
Border Palette 
Glow Palette 
Shadow Palette 
Edge Palette 
Bevel Palette 
Preferences 
Photoshop Lightroom Use 
Aperture Use 
Batch Processing 

 The onOne menu is a special menu that will appear in the menu bar in 
Photoshop between the Window and Help menu. From the onOne 
menu have access to any of your onOne products including 
PhotoFrame. You can open PhotoFrame, the batch dialog or apply 
your saved presets, including your last used settings directly from 
this menu. 

   
  The new onOne Panel in Adobe Photoshop provides fast access to 
all the modules of Plug-In Suite 5. This allows the user to quickly 
launch a module without having to navigate through Photoshop's 
menus. But it takes that power even farther by giving users access to 
their favorite effects and presets right from the panel as well. This 
will save users time by allowing them to apply their most frequently 
used effects right inside of Photoshop.  

● To use the onOne menu you need to open it from the 
Window > Extensions menu. Once it is open, it will remain 
open like any other Photoshop palette. 

● The onOne menu is available in Photoshop CS4 and above. 
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Photoshop Lightroom Use 

Installing PhotoFrame 4.5 for Lightroom 

 

See also 

 

 
 PhotoFrame 4.5 can now be accessed inside of Adobe 
Photoshop Lightroom 2. This allows you to add a frame or 
preset group of frames or design elements to a single 
image or group of images right inside the workflow 
application you use day in and day out. 
 
PhotoFrame provides a round-trip workflow experience. 
Just a few seconds after pressing the Apply button you will 
see your results from PhotoFrame right inside of Lightroom. 
PhotoFrame for Lightroom uses Photoshop as the imaging 
engine for hosting PhotoFrame. 
 

 

 When you install PhotoFrame it will automatically install the 
components for Lightroom as well. You will need to manually enable 
the PhotoFrame Lightroom plug-in to be able to use it. Follow these 
instructions: 

1. Open Lightroom 2  
2. Go File > Plug-in Manager. The dialog to the right will appear  
3. The right hand side should show you the path to the newly 

installed PhotoFrameConduit.lrplugin file.  
4. Click on the Enable button.  
5. Press Done 

 

Applying a Preset 
Manual Use 
Batch Processing 
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Applying a Preset 

 

 
 To Apply a PhotoFrame preset or favorite to an image or group of 
images in Photoshop Lightroom follow these instructions: 

1. Open Photoshop Lightroom  
2. Select an image(s)  
3. Go to File > Plug-in Extras  
4. Select PhotoFrame  
5. The PhotoFrame for Lightroom dialog will appear, select a 

preset from the list and press Apply. 

 
For Details on using the PhotoFrame for Lightroom dialog look below.  
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See also 

Manual Use 
Batch Processing 

This the PhotoFrame for Lightroom dialog. It consists of these controls: 

● Search: Type in the name of a preset or favorite frame. The results will appear in 
the Search Results category.   

● Category List: Lists your preset categories as well as a special category for your 
Favorites. Click on the triangle to open each category, just like the Library in 
PhotoFrame.  

● Description: Displays the description for the selected preset. You can close this 
section by clicking on the triangle next to the section title.  

● Options: The controls how your image is treated before it is sent to PhotoFrame. 
You can select from editing the original, a copy with Lightroom Adjustments applied 
or a just a copy. If you select either of the copy options you may also select the file 
format, color space and bit depth. If you have multiple versions of Photoshop 
installed you may also select which version of Photoshop to use PhotoFrame in. The 
last option, Stack with original will place the edited version of your image in the 
Lightroom catalog with the original.  You can close this section by clicking on the 
triangle next to the section title. These settings are remembered.  

● Cancel: Cancels PhotoFrame for Lightroom  
● Open...: Rather than applying a preset directly, this option will open your image in 

PhotoFrame so you can manually select the frame(s) and options  
● Apply Preset: Applies the selected preset to your image(s) 

 

 Note: If you have camera raw files in your selection you will not be able to 
use the Edit Original option.

Note: PhotoFrame for Photoshop Lightroom is only available with 
PhotoFrame Professional Edition and a full version of Photoshop, not 
Photoshop Elements.
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Manual Use 

 

 
 To Apply PhotoFrame with manual, custom interaction to an image or 
group of images in Photoshop Lightroom follow these instructions: 

1. Open Photoshop Lightroom  
2. Select an image(s)  
3. Go to File > Plug-in Extras  
4. Select PhotoFrame  
5. The PhotoFrame for Lightroom dialog will appear, select the 

Open... button. 

 
For Details on using the PhotoFrame for Lightroom dialog look below.  
 

 

 Tip: If you have multiple images selected and you press 
the Open...button you will be apply to manually set-up a 
frame stack for the first image. Each subsequent image in 
your selection will have the same frame stack applied to it 
as the first image.
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See also 

Applying a Preset 
Batch Processing 

This the PhotoFrame for Lightroom dialog. It consists of these controls: 

● Search: Type in the name of a preset or favorite frame. The results will appear in 
the Search Results category.   

● Category List: Lists your preset categories as well as a special category for your 
Favorites. Click on the triangle to open each category, just like the Library in 
PhotoFrame.  

● Description: Displays the description for the selected preset. You can close this 
section by clicking on the triangle next to the section title.  

● Options: The controls how your image is treated before it is sent to PhotoFrame. 
You can select from editing the original, a copy with Lightroom Adjustments applied 
or a just a copy. If you select either of the copy options you may also select the file 
format, color space and bit depth. If you have multiple versions of Photoshop 
installed you may also select which version of Photoshop to use PhotoFrame in. The 
last option, Stack with original will place the edited version of your image in the 
Lightroom catalog with the original.  You can close this section by clicking on the 
triangle next to the section title. These settings are remembered.  

● Cancel: Cancels PhotoFrame for Lightroom  
● Open...: Rather than applying a preset directly, this option will open your image in 

PhotoFrame so you can manually select the frame(s) and options  
● Apply Preset: Applies the selected preset to your image(s) 

 

 Note: If you have camera raw files in your selection you will not be able to 
use the Edit Original option.
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Batch Processing 

 
 

See also 

Applying a Preset 
Manual Use 

  
You can also use PhotoFrame from inside the Export Dialog in 
PhotoFrame 4.5 to batch process multiple images and add a frame or 
stack of design elements to them. To use PhotoFrame from the 
Export Dialog follow these steps: 

1. Open Photoshop Lightroom  
2. Select the images you would like to process  
3. Go to File > Export...  
4. From the export module pop-up, select PhotoFrame  
5. Set your options each of the module sections  
6. Press Export 

Most of the module sections are the same as the standard Lightroom 
export module. These include options for the location, name, size, file 
type etc. of the files you are exporting. See the Lightroom user guide 
for details on these options. 
 
In the PhotoFrame section you can select the category and preset 
that you would like to use. 

 

 
 

  
80 . Using PhotoFrame

 
  

  
PhotoFrame 4.5 User Guide



Home > Using PhotoFrame > Aperture Use 

Aperture Use 

 
 

See also 

 

 
 PhotoFrame 4.5 can now be accessed inside of Apple Aperture 2.1 
This allows you to add a frame or preset group of frames or design 
elements to a image right inside the workflow application you use day 
in and day out. PhotoFrame provides a round-trip workflow 
experience which keeps you right inside of Aperture and has no need 
to use Photoshop. 
 
The following pages will describe how to accomplish this. 
 

 

Using Presets 
Manual Use 
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Using Presets 

 

 

See also 

Manual Use 

 
 To Apply a PhotoFrame preset or favorite to an image or group of images 
in Apple Aperture follow these instructions: 

1. Open Apple Aperture  
2. Select an image  
3. Right click (control-click) on the image  
4. The contextual menu will appear, select Edit With  
5. Select PhotoFrame  
6. The PhotoFrame for Aperture dialog will appear, select a preset from 

the list and press Apply. 

 
For Details on using the PhotoFrame for Aperture dialog look below.  

 

This the PhotoFrame for Aperture dialog. It consists of these controls: 

● Search: Type in the name of a preset or favorite frame. The results will appear in the 
Search Results category.   

● Category List: Lists your preset categories as well as a special category for your 
Favorites. Click on the triangle to open each category, just like the Library in 
PhotoFrame.  

● Description: Displays the description for the selected preset. You can close this section 
by clicking on the triangle next to the section title.  

● Cancel: Cancels PhotoFrame for Lightroom  
● Open...: Rather than applying a preset directly, this option will open your image in 

PhotoFrame so you can manually select the frame(s) and options  
● Apply Preset: Applies the selected preset to your image(s) 

 

 Note: Aperture will always create a copy of your image for editing. You can control 
the file type and options that it creates in the Aperture preferences.
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Manual Use 

 

 

See also 

Using Presets 

 
 To Apply a PhotoFrame preset or favorite to an image or group of images 
in Apple Aperture follow these instructions: 

1. Open Apple Aperture  
2. Select an image  
3. Right click (control-click) on the image  
4. The contextual menu will appear, select Edit With  
5. Select PhotoFrame  
6. The PhotoFrame for Aperture dialog will appear, press the Open... 

button.  
7. Your image will open in PhotFrame where you can select the frame 

or design elements you desire and adjust them.  
8. Press the Apply button in PhotoFrame to apply the results and 

return to Aperture. 

 
For Details on using the PhotoFrame for Aperture dialog look below.  

 

This the PhotoFrame for Aperture dialog. It consists of these controls: 

● Search: Type in the name of a preset or favorite frame. The results will appear in the 
Search Results category.   

● Category List: Lists your preset categories as well as a special category for your 
Favorites. Click on the triangle to open each category, just like the Library in 
PhotoFrame.  

● Description: Displays the description for the selected preset. You can close this section 
by clicking on the triangle next to the section title.  

● Cancel: Cancels PhotoFrame for Lightroom  
● Open...: Rather than applying a preset directly, this option will open your image in 

PhotoFrame so you can manually select the frame(s) and options  
● Apply Preset: Applies the selected preset to your image(s) 

 

 Note: Aperture will always create a copy of your image for editing. You can control 
the file type and options that it creates in the Aperture preferences.
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Batch Processing 

PhotoFrame is much more than just a framing program, it also adds a powerful batch processor to your workflow. With the PhotoFrame batch engine you 
can apply an entire stack of design elements to create a layout, to a group of images at the same time and even create new child documents from them in 
different sizes and formats. This can be a huge time saver in your workflow while at the same time allowing you to be creative in the look you apply to your 
images. The following will explain the options within the batch engine and give you several ideas how you can use it in your studio.  
 

Opening the Batch Engine  
 
The PhotoFrame batch engine can be accessed from either the onOne menu directly or from inside of PhotoFrame from the File menu. The only difference 
between these options are which presets you have access to. When you open Batch directly from the onOne menu you have access to any of your saved 
presets. You can also use the batch engine with the  “none” option which will allow you to use the batch engine features such as resizing and renaming 
without applying PhotoFrame. If you open the batch engine from inside of PhotoFrame you have access to all your presets, your current frame stack or the 
Randomizer. 

See also 

Using the Library 
Using the Preview Window 
Frame Stack Palette 
Adding a Random Frame 
Adding an Instant Frame 
Options Palette 
Background Palette 
Color Picker 
Border Palette 
Glow Palette 
Shadow Palette 
Edge Palette 
Bevel Palette 
Preferences 
onOne Menu and onOne Panel 
Photoshop Lightroom Use 
Aperture Use 
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Frames Tab 

 
 

See also 

Source Tab 
Destination Tab 
File Naming Tab 
File Type Tab 
Watermark Tab 
Logging 

The Frames tab is the first (far left) tab of the batch dialog. Note that each tabs 
are numbered in the order that they should be completed. The Frames tab 
allows you to select which stack preset you wish to process your files with.  
 
If you opened Batch directly from the onOne menu (or the automate menu) you 
have access to all of your saved presets as well as the none option. The None 
option allows you to use the features of the batch engine without adding any 
frames from PhotoFrame. 
  
If you opened Batch from inside of PhotoFrame you will  
see the Current Stack option available, which uses your current Frame Stack in 
PhotoFrame. You also have access to your saved presets as well as the 
randomizer option to add a different, random frame to each image in your 
batch. 
 

 

 
  

  
Using PhotoFrame . 85

 
 

  
PhotoFrame 4.5 User Guide



Home > Using PhotoFrame > Batch Processing > Source Tab 

Source Tab 

 
 

See also 

Frames Tab 
Destination Tab 
File Naming Tab 
File Type Tab 
Watermark Tab 
Logging 

  
The source tab helps you define which files to process. It has the option of the 
files currently open in Photoshop or a folder of images. If you select the files 
currently open in Photoshop, PhotoFrame will apply the selected stack to all 
images open in Photoshop and leave them open upon completion. Please note 
that when using this option that the destination, file naming and file type tabs 
are disabled.  
 
If you use the folder option you can define a folder on your computer, attached 
drive or network drive that contains the images you which to process. Press the 
Choose... button to select the folder you wish to use. The path line confirms 
the location visually. There is a checkbox labeled include subfolders, which will 
look inside the source folder for subfolders and files that they may contain.
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Destination Tab 

 

 

See also 

Frames Tab 
Source Tab 
File Naming Tab 
File Type Tab 
Watermark Tab 
Logging 

 The destination tab helps you define where to put the files that are batch 
processed. It is similar to the source tab and has two options. The first is save 
and close. When this option is selected each file that is processed will be saved 
with the same name and file type as the original. If your source files are camera 
raw files they will be saved as PSD files. If you use the folder option you can 
create new child documents from your original files. You can control the names 
and file types in the File Names and File Types tabs. Use the Choose... button 
to select the folder where you would like the new files to live.  
 
Like the source tab there is also an option to create matching subfolders if the 
source folder has subfolders. For example iif your source folder has subfolders 
named ceremony, formals and reception the PhotoFrame will create matching 
subfolders in the destination folder and place the new files in the matching 
folder structure as the originals.

 

 

 Note: Using the save and close option may overwrite your original files.  
 
Note: Using the same source and destination paths without changing the file names or file types can result in overwriting your original files. 
PhotoFrame will detect overwriting and ask you to confirm.  

 
  

  
Using PhotoFrame . 87

 
 

  
PhotoFrame 4.5 User Guide



Home > Using PhotoFrame > Batch Processing > File Naming Tab 

File Naming Tab 

 
 

 

Here are some examples of ways you can name your batch processed files. 

 

 
 
See also 

Frames Tab 
Source Tab 
Destination Tab 
File Type Tab 
Watermark Tab 
Logging 

  
The file naming tab allows you to determine the name of new files created 
through batch processing. You are allowed to add up to six naming articles, or 
segments, consisting of the original file name, the date, serial number or custom 
text.

 

Article   What is It?

 Current Name
 The original filename without the extension. PhotoFrame will always add the proper extension to the end of the filename.  
 
Example: DSC007

Current Name and 
Extension

 The original filename and extension. PhotoFrame will always add the proper extension to the end of the filename. Use this option if 
would like to add the original extension to the file name as well as the current extension.  
 
Example: DSC007.jpg

 Text
 A line of text of your choice up to 32 characters long. This could be a job or client name or anything you like.  
 
Example: whateverIwant

 Serial Number

 A numerical serial number. It may be up to eight digits long and supports leading zeros. You can specify any number to start with. 
Each file will be numbered sequentially starting with your first number.  
 
Example: 0001

 Date
Todays date in YYMMDD format.  
 
Example: 070926

 Articles Example 
 Text+Serial Number  myfile_001.jpg
 Original Name+Text+Serial Number  DSC007_Johnson_001.jpg
 Text+Date+Serial Number  myfile_070926_001.jpg
 Original Name with Extension+Text  DSC007.CR2_Converted.jpg
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File Type Tab 

 
 

See also 

Frames Tab 
Source Tab 
Destination Tab 
File Naming Tab 
Watermark Tab 
Logging 

The File Type tab allows you to determine the file type of the new files to be 
created as well as their size, resolution and color profile. You can also have 
PhotoFrame create an additional JPEG as well as the new files.  
 
The first option is File Type. You can select from Same as Source, PSD 
(Photoshop native file), TIFF or JPEG. If you use the same as source option, 
PhotoFrame will save the new files in the same format as the original file. For 
camera raw files, this option will create PSD files instead. Selecting one of the 
other formats will create that type of file.  
 
For each format selected there may be additional options to select. For example 
if you select JPEG you can determine the Quality (compression ratio) of the file. 
For TIFF and PSD files you have the option of flattening layers and for TIFF you 
can also enable LZW compression.  
 
You can also select to resize the new files. Simply turn on the resize to fit option 
and enter the maximum width and height. These dimensions can be in pixels, 
inches, centimeters or percentage. The proportions of the image will always be 
maintained. The image will be resized to fit within the dimensions entered. When 
resizing files PhotoFrame will use the default interpolation algorithm selected in 
your Photoshop preferences. You can also adjust the resolution of your files as 
well. If you enter no resolution, the current files resolution will be used.  
 
You can also convert the new files to a destination color space. From the 
Convert to Profile pop-up select the ICC profile you wish to use. In most cases 
be sure to select embed profile option as well to embed the profile so that 
others that open the new files will be able to view them properly color managed. 
 
 
Saving Additional JPEG  
You can also save an additional JPEG file from your new batch processed files. 
When saving an additional JPEG you have the same options for resizing and 
color space as you do when creating new the primary file. Your additional JPEG 
files will be saved in a folder labeled JPEG inside your destination folder.
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Watermark Tab 

 

 The batch engine also allows you to add a visual watermark file to your batch 
processed files. This watermark is created from a source file of your choosing. 
You have the option to enable watermarking as well as limit the watermarking 
function to just the additional JPEG files.  
 
Start by turning the watermarking option on by checking the enable 
watermarking check box. This will add your watermark to all the files created in 
the batch. If you wish to only add the watermark to the additional JPEG files, be 
sure to enable the check box labeled “Only Watermark Additional JPEG.” You 
can choose where on the image the watermark will appear by selecting the 
position from the position pop-up. To select the file to be used for the 
watermark, press the Choose... button.  
 
It is important to properly prepare the file you wish to use for your watermark. 
PhotoFrame simply pastes the watermark file into your new file. It does not 
resize or alter the watermark. Below are some guidelines for creating your 
watermark file.  
 

● Watermark files should be sized to fit the intended destination file. For 
example if you are creating 640x480 pixel output files your watermark 
file needs to be smaller than that.  

● If you want your watermark to have a transparent background, 
prepare your watermark as such and save it has a PNG file to maintain 
the transparency.  

● If you want your watermark to have a reduced opacity, prepare your 
watermark file as such and be sure to save it as a PNG file to maintain 
the opacity. 

 

 

  

Open your logo file. In this case our logo is a single color black on a white background. 

 

  

If your image consists of only a background, convert it to a layer by doubleclicking on it in the layers palette. 

 

 Use the magic wand tool in Photoshop and click on the white background. Assuming your logo is a crisp black 
on a clean white this should only select the white background.
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See also 

Frames Tab 
Source Tab 
Destination Tab 
File Naming Tab 
File Type Tab 
Logging 

 

 Press the delete button to remove the white background leaving your logo on a ransparent checkerboard.

 

 If you would like your logo to be white, invert your image by going to Image- >Adjust-Invert. You should now 
have your logo in white.

 
To reduce the opacity, change the opacity slider in the layers palette to approximately 50%.

 

 Resize your file to fit comfortably within your output files. In this case lets assume you are creating small 
JPEG files for your website which are a maximum of 600 pixels. We don’t want our logo to cover the entire 
image, but the center area,so use the Image Size dialog to size the file to about 100 pixels.

 

Finally save your file as a .PNG file. To the left is an example of the final watermark on an image using this 
technique.
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When the batch operation is completed you will see a dialog summarizing the results. In this dialog you have the option of displaying the batch log file by 
pressing the view log button. This will open the batch log for the last batch in your default web browser. The log file will display your selected options as 
well as the name, path and results for each file. If you received any error messages when running your batch you can see more information of which file(s) 
where effected by viewing the log. If you encounter errors and can not determine their cause visit the Knowledge Base at the onOne website for 
troubleshooting tips. 
 

See also 

Frames Tab 
Source Tab 
Destination Tab 
File Naming Tab 
File Type Tab 
Watermark Tab 
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Menus 

Pages in this Section 

 

 
Photoshop (Mac OSX) 

 
File 

 
Edit 

 
Frame 

 
View 

 
Window 

 
Help 
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Photoshop (Mac OSX) 

 

 

See also 

File 
Edit 
Frame 
View 
Window 
Help 

About PhotoFrame 4.5...: Opens the PhotoFrame about box. This 
dialog contains your serial number, version number and information on 
contacting onOne Software for support. 
 
PhotoFrame 4.5 Preferences...: Opens the PhotoFrame 
4.5 preferences dialog. 

 

 

 Tip: On Windows, the preferences can be found in the Edit menu, the About Box can be found in the Help menu.
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File 

 
 

See also 

Photoshop (Mac OSX) 
Edit 
Frame 
View 
Window 
Help 

Cancel/Close: Cancels PhotoFrame and returns back to the host application with no changes. 
 
Apply: Applies the current Frame Stack and options to your image and returns to the host application. 
 
Batch...: Opens the PhotoFrame Batch engine dialog where you can apply a PhotoFrame preset to a 
group of images. 
 
Import Frame...: Opens the import frame dialog where you can select frames or elements you would 
like to add to your PhotoFrame Library. 
 
Save Preset...: Opens the save preset dialog where you can save the current Frame Stack and options 
as a preset for future use or sharing. 
 
Open Preset Folder...: Opens the PhotoFrame preset folder in the Finder (Mac) or Explorer (Win). This 
folder contains the individual preset files.
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Edit 

 
 

See also 

Photoshop (Mac OSX) 
File 
Frame 
View 
Window 
Help 

Undo: Reverses the last user action 
 
Redo: Reapplies the last user action if it has been undone.  
 
Copy: Copies the current text into the clipboard. 
 
Cut: Cuts the current text into the clipboard. 
 
Paste: Pastes the content of the clipboard. 
 
Reset All: Resets all the floating palette controls back to their default settings. 
 
Preferences (Windows Only): Opens the PhotoFrame 4.5 preferences dialog. 

The following options apply to the Library only 
 
Select All: Selects all the items in the thumbnail area. 
 
Inverse Selection: Inverts the selection in the thumbnail area. 
 
Deselect: Deselects all the items in the thumbnail area. 
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Frame 
 

 
 
See also 

Photoshop (Mac OSX) 
File 
Edit 
View 
Window 
Help 

 

Note: The controls in the Frame menu apply to elements selected in the Frame Stack while working in the Preview window only. They do not 
control elements in the Library window.

 Add Instant Frame: Adds an instant frame to the Frame Stack and opens the Instant Frame 
palette if it is closed. 
 
Add Randomizer Frame: Clears the current stack and adds a random group of frames and 
elements based on your preferences. 
 
Invert Frame: Inverts the current frame. This will make the inner area of the frame the 
background. 
 
Delete Frame: Removes the current frame from the stack. 
 
Rotate: The rotate commands rotate the current frame 90 degrees clockwise or counter 
clockwise. 
 
Flip: The flip commands will flip the frame either horizontally or vertically. 
 
Link All Frames: Links all the elements in the stack together, making it easier to move and 
reposition them together. 
 
Find Frames Online...: Opens your default web browser and navigates to the onOne 
Exchange where you can find additional frames and presets.
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Home > Menus > View 

View 
 

 
 

See also 

Photoshop (Mac OSX) 
File 
Edit 
Frame 
Window 
Help 

 

Note: The controls in the View menu apply to working in the Preview window only. They do not effect the Library window.

Zoom In: Zooms the preview window in one increment. This will make the preview image larger. 
 
Zoom Out: Zooms the preview window out one increment. This will make the prevewi images 
smaller. 
 
Fit on Preview: This sets the preview image so that the entire image is on screen at once. Think 
of this as an overview of the entire image. This is the setting you will use most of the time. 
 
Actual Pixels: This sets the preview image so that it zooms to actual pixels or 1:1 also called 
100%. This setting allows you to see every pixel in the image. This is useful when making precision 
adjustments or adjusting texture opacities. 
 
Show/Hide Composite Layer: This command will disable composite viewing, showing your 
PhotoFrame results with only the target layer and will not show the layers above or below your 
target layer. 
 
Show/Hide Rulers: Shows or hides the rulers. 
 
Show/Hide Guides: Shows or hides the guides. 
 
Clear Guides: Clears (removes) any guides that have been placed.
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Home > Menus > Window 

Window 

 
 

See also 

Photoshop (Mac OSX) 
File 
Edit 
Frame 
View 
Help 

 
Hide/Show [palette name]: Hides or shows the named palette. 
 
View Frame Library: Opens the Library window 
 
Welcome Dialog: Opens the Welcome Dialog which shows basic step-by-step instructions for using 
PhotoFrame.
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Help 

 
 

See also 

Photoshop (Mac OSX) 
File 
Edit 
Frame 
View 
Window 

Search: Not used, Mac OSX only 
 
PhotoFrame Help...: Opens this html help in your default web browser. 
 
Find Tutorials Online...: Opens your web browser and navigates to 
the tutorials section of the onOne website. 
 
Disable Hot Help: Disables the Hot Help (tool-tips) that appear when 
you hover over a control. 
 
Check for PhotoFrame 4 Updates...: Checks with the onOne update 
server to see if you are running the current version. If there is a newer 
version you will be notified and be walked through the update process. 
 
Activate/Deactivate: Opens the activation dialog. These are used to 
deactivate your software for moving it to another computer or for a 
return. 
 
About PhotoFrame (Windows Only): Opens the about box with the 
version number and license code displayed.
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